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CHAPTER ONE 

INTRODUCTION 

1.1 BACKGROUND 

SIWES (Student Industrial Work Experience Scheme) was introduced in Nigeria in 1973 by the 

National Board for Technical Education (NBTE). Its primary aim is to provide students in 

Nigerian higher institutions with practical work experience in their field of study. SIWES was 

designed to bridge the gap between academic knowledge and practical skills, helping students 

acquire the necessary skills to enhance their employability upon graduation. 

Initially, it was intended for students in technical and vocational courses, but over time, it 

expanded to include students in various fields of study such as engineering, sciences, and social 

sciences. SIWES is a mandatory program for students in polytechnics, universities, and colleges 

of education, and it is typically carried out in industries, government establishments, and private 

organizations. 

During the program, students are expected to gain hands-on experience in their chosen 

profession, interact with industry experts, and improve their practical knowledge, thus making 

them more competitive in the job market. The scheme is coordinated by both the institutions and 

the industrial establishments, and students are usually required to submit reports and evaluations 

based on their experiences. 

1.2 OBJECTIVES      

The main objectives of the Student Industrial Work Experience Scheme (SIWES) are: 

1. To expose students to real-world work environments: SIWES aims to provide students 

with practical experience in their chosen field of study, complementing theoretical 

knowledge acquired in the classroom. 
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2. To develop students' technical and professional skills: By working in industries, students 

are able to hone their technical abilities, adapt to industry standards, and gain relevant job-

related skills. 

3. To prepare students for the labor market: The program helps students acquire the 

practical skills and experience needed to be more competitive and employable after 

graduation. 

4. To enhance students' understanding of their course of study: Through hands-on 

experience, students are able to better understand how their academic studies are applied in 

real-world scenarios. 

5. To foster collaboration between institutions and industries: SIWES serves as a platform 

for partnerships between academic institutions and industries, facilitating knowledge 

exchange and helping to improve the educational curriculum based on industry needs. 

6. To improve students' attitude to work and increase their productivity: The program 

encourages professionalism, time management, and work ethics, ultimately leading to a well-

rounded and disciplined workforce. 

7. To contribute to national development: By equipping students with the skills necessary for 

industrial and professional advancement, SIWES contributes to the overall growth and 

development of the nation's economy. 
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CHAPTER TWO 

DESCRIPTION OF THE ESTABLISHMENT OF ATTACHMENT 

2.1 LOCATION AND BRIEF HISTORY OF AUSTINEANNEADEX INFORMATION 

TECHNOLOGY  

Austineanneadex Information Technology is located at 78 Oniwa’s Complex, Old Shao Garage 

Off Sobi Road, Ilorin, in Ilorin East of Kwara State, Nigeria and was established in the 2019 and 

was fully registered with Corporate Affairs Commission (CAC) in the year 2019.  

2.2 OBJECTIVES OF AUSTINEANNEADEX INFORMATION TECHNOLOGY 

 Provide Quality IT Education: To deliver high-quality training programs in various IT 

fields, including programming, networking, cybersecurity, web development, and data 

science, to equip students with essential skills for the modern workforce. 

 Foster Hands-On Learning: To offer practical, hands-on experience in using real-world 

technologies and tools, enabling students to gain valuable skills that can be directly applied 

in the workplace. 

 Support Certification Programs: To offer courses and support for industry-recognized 

certifications in IT fields, helping students improve their credentials and employability. 

 Provide a Safe and Secure Learning Environment: To implement strong cybersecurity 

practices within the institute’s network and systems, ensuring students' personal data, as well 

as learning resources, are protected. 

 Promote Digital Literacy: To ensure that students, regardless of their prior knowledge, are 

equipped with foundational digital literacy skills, enabling them to be comfortable and 

proficient with technology in various contexts. 

 Enhance Career Services and Placement Support: To provide career counseling, 

internships, and placement assistance to students, helping them secure jobs in the IT industry 

upon completing their training. 

 Develop a Collaborative Learning Culture: To foster a collaborative learning environment 

where students can engage with peers, instructors, and industry professionals, facilitating 

knowledge exchange and teamwork. 
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 Invest in Cutting-Edge Equipment and Software: To provide students with access to the 

latest computers, software, and networking technologies, ensuring they have the tools 

necessary for optimal learning. 

 Encourage Continuous Learning and Development: To promote a culture of lifelong 

learning by offering continuing education opportunities, workshops, and seminars for 

students and professionals who wish to stay updated with emerging IT trends and 

technologies. 

2.3 ORGANIZATION STRUCTURE (ORGANOGRAM)  

 

 

 

 

       

2.4 OVERVIEW OF VARIOUS DEPARTMENTS AND FUNCTIONS 

 Managing Director: The one responsible for the overall affairs of the organization 

 Sales Department: The one responsible for the market sales of the organization 

 Marketing Department: The one responsible for marking strategy of the establishment 

 Training Department: The department responsible for the training of student in the 

establishment 

  

SALES 

DEPARTMENT 

MANAGING DIRECTOR 

MARKETING 

DEPARTMENT 

TRAINING 

DEPARTMENT 
 



9 | ND/23/BFN/FT/0055 

CHAPTER THREE  

3.0 DESCRIPTION OF WORK DONE 

3.1 INTRODUCTION TO COMPUTER 

Computer: is an electronic device that operates (works) under the control of programs stored in 

its own memory unit.  

A computer is an electronic machine that processes raw data to give information as output. 

 

An electronic device that accepts data as input, and transforms it under the influence of a set of 

special instructions called Programs, to produce the desired output (referred to as Information). 

 

 

 

 

 

 

 

 

 

 

Explanations; 

A computer is described as an electronic device because; it is made up of electronic components 

and uses electric energy (such as electricity) to operate. 

A computer has an internal memory, which stores data & instructions temporarily awaiting 

processing, and even holds the intermediate result (information) before it is communicated to the 

recipients through the Output devices. 

Program: 

A computer Program is a set of related instructions written in the language of the computer & is 

used to make the computer perform a specific task (or, to direct the computer on what to do). 
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A set of related instructions which specify how the data is to be processed. A set of instructions 

used to guide a computer through a process. 

Data: Is a collection of raw facts, figures or instructions that do not have much meaning to the 

user. 

 Data may be in form of numbers, alphabets/letters or symbols, and can be processed to produce 

information 
 

TYPES OF DATA 

There are two types/forms of data: 

a). Digital (discrete) data: Digital data is discrete in nature. It must be represented in form of 

numbers, alphabets or symbols for it to be processed by a computer. Digital data is obtained by 

counting. E.g. 1, 2, 3 … 

b). Analogue (continuous) data: Analogue data is continuous in nature. It must be represented 

in physical nature in order to be processed by the computer.  Analogue data is obtained by 

measurement. E.g. Pressure, Temperature, Humidity, Lengths or currents, etc. The output is in 

form of smooth graphs from which the data can be read. 

Data Processing: 

It is the process of collecting all items of data together & converting them into information. 

Processing refers to the way the data is manipulated (or handled) to turn it into information. 

The processing may involve calculation, comparison or any other logic to produce the required 

result. The processing of the data usually results in some meaningful information being 

produced. 

 

Information: is the data which has been refined, summarized & manipulated in the way you 

want it, or into a more meaningful form for decision-making.  The information must be accurate, 

timely, complete and relevant. 

Characteristics / Features of a Computer. 
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3.2 OPERATING SYSTEM 

An operating system (OS) manages a computer's resources, including memory, processes, and 

devices. It also provides services to users and helps prevent errors.  

3.2.1 FUNCTIONS OF OPERATING SYSTEM 

 Process Management: Oversees programs and processes, allocating resources like memory 

and CPU time  

 Memory Management: Manages the allocation and deallocation of memory to processes  

 File Management: Tracks where data is stored, manages and deletes files, and sets user 

access permissions  

 Device Management: Manages input, output, and storage devices, ensuring they run 

efficiently and safely  

 Security: Prevents unauthorized access to data, and may use firewalls to monitor and block 

threatening activity  

 Network Management: Enables communication and data exchange between systems over a 

network  

 Secondary Storage Management: Manages permanent storage, such as a computer's hard 

drive  

 Error Handling: Detects and handles errors or bugs that may arise during tasks  

 Multitasking: Allows a computer to run multiple tasks simultaneously  

An OS also provides an interface to the user, hides the complexity of software, and supports 

multiple execution modes. 

There are many types of operating systems (OS), including mobile, distributed, real-time, and 

multitasking.  

3.2.2 TYPES OF OPERATING SYSTEMS 

 Distributed OS: Runs on a network of computers, allowing them to work together.  

 Real-time OS: Processes data as it comes in, often used in embedded systems like medical 

or automotive applications.  

 Multitasking/Time Sharing OS: Gives each task some time to execute so that all tasks work 

smoothly.  
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 Multiprogramming OS: Manages memory allocation and deallocation for multiple 

processes running concurrently.  

 Mobile OS: Optimized for smaller screens and less powerful hardware.  

 Linux: A Unix-like, open source, and community-developed OS for computers, servers, 

mobile devices, and embedded devices.  

 macOS: A popular OS, especially among creative professionals and users who prioritize 

minimalistic design.  

 Unix: A multiuser, multitasking OS designed for flexibility and adaptability.  

When choosing an OS, you can consider things like: Cost, Compatibility, Ease of use, and 

Security.  

3.3 COMPUTER SOFTWARE 

Software comprises programs, data, and instructions that a computer uses to carry out specific 

functions.  

Purpose: 

It allows a computer to perform tasks, from running applications like word processors to 

managing the computer's internal operations.  

Intangible: 

Unlike hardware (physical components), software is not something you can physically touch or 

hold.  

Examples: 

Examples include operating systems (like Windows or macOS), applications (like web browsers 

or video editors), and utilities (like antivirus software).  

3.3.1 TYPES OF SOFTWARE: 

 System Software: This software manages the computer's hardware and provides a platform 

for other software to run.  

 Operating Systems (OS): The core system software that manages hardware resources and 

provides a user interface (e.g., Windows, macOS, Linux).  

 Device Drivers: Software that allows the operating system to communicate with specific 

hardware devices (e.g., printer drivers, graphics card drivers).  
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 Utilities: Programs that perform maintenance tasks, such as disk cleanup, file management, 

or system diagnostics.  

3.3.2 APPLICATION SOFTWARE: 

These are programs designed to perform specific tasks for users.  

 Word Processing Software: Used for creating and editing text documents (e.g., Microsoft 

Word, Google Docs).  

 Spreadsheet Software: Used for organizing and analyzing data in tables (e.g., Microsoft 

Excel, Google Sheets).  

 Presentation Software: Used for creating and delivering slideshow presentations (e.g., 

Microsoft PowerPoint, Google Slides).  

 Database Software: Used for storing, organizing, and managing data (e.g., Microsoft Access, 

MySQL).  

 Web Browsers: Used for accessing and viewing web pages (e.g., Chrome, Firefox, Safari).  

 Graphics Software: Used for creating and editing images (e.g., Adobe Photoshop, GIMP).  

 Multimedia Software: Used for creating and playing multimedia content (e.g., video editors, 

audio players).  

 Educational Software: Used for learning and teaching purposes.  

3.4 INSTALLATION OF SOFTWARE 

To install software, you typically download the installation file (like a .exe file), then run it and 

follow the on-screen instructions.  

Here's a more detailed breakdown: 

1. Find the Software: 

o Reliable Source: Always download software from the official website of the software 

developer or a trusted source.  

o Search: Use a search engine to find the software's website and download link.  

o Download: Click the download button or link to start the download process.  

2. Download and Save: 

Save Location: 

Choose a location to save the downloaded file (e.g., Downloads folder or your desktop). 
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Check for Viruses: 

Before installing, it's a good idea to scan the downloaded file for viruses with your antivirus 

software.  

3. Installation Process: 

o Run the Installer: Double-click the downloaded file (e.g., a .exe file) to start the installation 

process. 

o Follow Instructions: Carefully follow the instructions provided by the installation wizard. 

o License Agreement: You'll likely need to agree to a license agreement. 

o Installation Location: You might be asked to choose where to install the software. 

o Components: You might be able to choose which components or features to install. 

o Shortcuts: You can choose to create shortcuts on your desktop or start menu.  

4. Launch and Use: 

o Launch: Once the installation is complete, you can launch the software. 

o Explore: Explore the software's features and functionalities.  

o Uninstall: If you no longer need the software, you can uninstall it through the Control Panel 

(Windows) or the Applications folder (Mac).  

3.5 MICROSOFT WORD 

Microsoft Word is a word processing program that allows users to create, edit, and store 

documents. It is part of the Microsoft Office suite of applications.  

3.5.1 FEATURES 

 Grammar and Spell Check: Helps users avoid errors  

 Image Support: Allows users to add images to their documents  

 Text and Font Formatting: Allows users to customize the appearance of their text  

 Page Layout: Allows users to configure the layout of their documents  

 HTML Support: Allows users to create documents that can be viewed in a web browser  

3.5.2 HOW TO USE MICROSOFT WORD  

 Open Microsoft Word 

 Select a blank document 

 Start typing 
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 Use the Ribbon to access commands 

 Use the Quick Access Toolbar to access common commands 

 Use the Tell Me bar to search for commands 

 Use the zoom control to adjust the size of the document 

3.5.3 MICROSOFT WORD INTERFACE 

3.5.4 TEXT FORMATTING 

To format text in Microsoft Word, you can use the formatting options on the Home tab. You can 

also use keyboard shortcuts.  

Formatting options  

 Font: Change the font, size, or color of text 

 Bold, italic, underline, and strikethrough: Apply these formatting options to text 

 Highlight: Select a color to highlight text 

 Subscript and superscript: Select text, then tap the down arrow and choose the option 

 Numbered and bulleted lists: Select text, then tap the appropriate icon 

 Alignment: Align text to the left, center, right, or justify it 

 Indentation: Decrease or increase the indentation 
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3.5.5 KEYBOARD SHORTCUTS  

Ctrl + B: Apply bold formatting 

Ctrl + Shift + L: Add a bulleted list 

Ctrl + U: Apply underline formatting 

Ctrl + Shift + W: Apply underline formatting to words, but not spaces 

3.5.6 FORMATTING STYLES 

You can also change the font for all text in a view using styles. To do this:  

Select Format > Text Styles 

Select All from the Item to Change dropdown list 

Choose the font, size, or color you want 

Formatting text can help make written work look more consistent and professional. It can also 

add emphasis, style, or additional meaning to text.  

 

Microsoft Word Interface  
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CHAPTER FOUR 

4.0 MICROSOFT EXCEL 

To format text in Excel, select the cells, then use the formatting options in the "Home" tab 

ribbon (e.g., font, size, color, alignment, bold, italic, underline) or use the "Format Cells" dialog 

box for more advanced options.  

Here's a more detailed breakdown: 

1. Basic Text Formatting: 

 Select Cells: Choose the cells containing the text you want to format.  

 Home Tab Ribbon: 

 Font: Change the font type, size, style (bold, italic, underline), color, and effects.  

 Alignment: Adjust text alignment within the cell (left, right, center, top, bottom, justify), 

wrap text, and orientation.  

 Wrap Text: Click the "Wrap Text" button to prevent text from overflowing into adjacent 

cells.  

 Merge & Center: Combine multiple cells into one and center the text within the merged cell.  

Keyboard Shortcuts: 

 Bold: Ctrl + B  

 Italic: Ctrl + I  

 Underline: Ctrl + U  

2. Advanced Formatting (Format Cells Dialog Box): 

 Right-click: on the selected cells and choose "Format Cells".  

 Format Cells Dialog Box: 

 Number: Change how numbers are displayed (e.g., currency, percentage, date, time).  

 Alignment: Fine-tune alignment options, including indentation, text direction, and cell 

orientation.  

 Font: More detailed font formatting options.  

 Border: Add or customize borders around cells.  

 Fill: Change the background color of cells.  

 Protection: Lock cells or hide them from specific users.  

3. Conditional Formatting: 



18 | ND/23/BFN/FT/0055 

Highlight Cells: 

Use conditional formatting to automatically format cells based on their values or other criteria. 

Home Tab > Conditional Formatting: 

Select the data, then choose from options like Highlight Cells Rules, Top/Bottom Rules, Data 

Bars, Color Scales, or Icon Sets.  

4. Tips for Text in Excel: 

Apostrophe: Use a single apostrophe (') before text to ensure Excel recognizes it as text and not a 

formula. 

Alt + Enter: Use Alt + Enter to create a new line within a cell. 

Highlight Text: You can format specific parts of text within a cell by highlighting them.  

DATA VALIDATION AND ANALYSIS 

How to Use Data Validation in Excel 

 Step 1: Select the Cells for Data Validation. First, identify the cells where you want to apply 

data validation. ... 

 Step 2: Open the Data Validation Dialog Box. ... 

 Step 3: Set Up Validation Criteria. ... 

 Step 4: Configure an Input Message (Optional) ... 

 Step 5: Customize the Error Alert (Optional) 

Microsoft Excel Interface  
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4.2 MICROSOFT POWERPOINT 

Microsoft PowerPoint is used for creating and delivering presentations with slides. 

Key Features: 

 Creating a Presentation: Open PowerPoint, select "New" to start a blank presentation or 

choose a template. 

 Adding Slides: Click "New Slide" on the Home tab to add slides. 

 Designing Slides: Use themes and design options under the "Design" tab. Add text, 

images, and multimedia. 

 Presenting: Click "Slide Show" > "Fr om Beginning" to start your presentation. 

Basic Shortcuts: 

 F5: Start slideshow 

 Esc: Exit slideshow 

 Ctrl + M: New slide 

Microsoft Powerpoint Interface  
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CHAPTER FIVE 

SUMMARY, CONCLUSION & RECOMMENDATION 

5.1 SUMMARY OF ATTACHMENT 

With regards to the 16 weeks industrial training undergone, I can strongly attest to the fact that 

the Student Industrial Work Experiences Scheme are highly important program for all students, 

this training has exposed me to skills I needs to utilize and apply in my field to break the gap 

between theory and practical aspects and has also given me a sense of full practical and market 

strategies to use in this filed. The training has made me a better entrepreneur as I now adopt what 

have learnt in this Students Industrial Work Experience Scheme. I am proud of my feet now than 

I was before knowing fully well on what to do in order to solve some of the nation’s problem in 

terms of employment opportunity. We are problem solver of the nation.  

My experience at Austineanneadex Information Technology has brought me up and unveiled the 

inner me into being a problem solver. My experience was indeed worthwhile through the help of 

the intern and staffs I worked with. 

5.2 PROBLEMS ENCOUNTERED DURING THE PROGRAM 

The success of my training is undisputed, but it was not devoid of rough edges. Some of the 

challenges include: 

1. Some of my colleagues there in the organization are not ready to learn and so whenever the 

supervisor senses an atmosphere of unseriousness the entire students under his supervision will 

be dealt with and this was a great burden upon me. 

2. The issue of expensive transportation. The cost of transport fee from my house to my place of 

assignment is too high 
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5.3 RECOMMENDATION/SUGGESTION FOR THE IMPROVEMENT OF THE 

SCHEME 

 Interns should be allowed to undergo full practical after they have been trained and 

properly tested 

 Students undertaking internship should understand the importance of the training and not 

joke about it. They should use this opportunity to be hardworking and enterprising. 

 Stipends should be added to help interns on daily expenses. 

 Regular supervision should be carried out by the SIWES’s supervisors for proper 

monitoring of the student 

 

 

 

 


